Learning QuickBooks Pro 2009 (Brunsdon)

Chapter 1   Get Ready for QuickBooks Pro

1) Accounting software eliminates tedious processes such as typing documents, manually posting and calculating transactions, and documenting the audit trail.

Answer:  TRUE

Diff: 1
Page Ref: 1

Objective:  1.1

2) Application software does not have to match the computer operating system software.

Answer:  FALSE

Diff: 1
Page Ref: 3

Objective:  1.1

3) When loading QuickBooks, the welcome screen has an overview tutorial that allows you to learn about how QuickBooks works.

Answer:  TRUE

Diff: 1
Page Ref: 6

Objective:  1.2

4) When loading QuickBooks, the welcome screen has a tab that allows you to practice using QuickBooks on your own by adding and changing data in a sample company file.

Answer:  TRUE

Diff: 1
Page Ref: 6

Objective:  1.2

5) When loading QuickBooks, the welcome screen has a tab that allows you to create a new company file.

Answer:  TRUE

Diff: 1
Page Ref: 6

Objective:  1.2

6) When you have loaded QuickBooks, the window that allows you to open an existing company is called the Company tab.

Answer:  FALSE

Diff: 1
Page Ref: 6

Objective:  1.2

7) To open a company file, you can double click the company name from the file location.

Answer:  TRUE

Diff: 1
Page Ref: 12

Objective:  1.3

8) You must be connected to the Internet to update your software.

Answer:  TRUE

Diff: 1
Page Ref: 13

Objective:  1.3

9) If the company uses Purchase Orders then the Vendors section of the Home page will show Purchase Orders as the first transaction in the workflow.

Answer:  TRUE

Diff: 2
Page Ref: 17

Objective:  1.4

10) By changing Preferences you can change icons displayed on the Home page.

Answer:  TRUE

Diff: 2
Page Ref: 18

Objective:  1.4

11) Home page icons are used to open frequently performed tasks.

Answer:  TRUE

Diff: 2
Page Ref: 18

Objective:  1.4

12) It is possible to activate any icons on the Home you choose even if the options are not listed in the Preference window.

Answer:  FALSE

Diff: 2
Page Ref: 18

Objective:  1.4

13) The Home and Center icons are isolated from the Navigation Bar and are displayed by selecting View>>Home and Center on the main menu.

Answer:  FALSE

Diff: 2
Page Ref: 19

Objective:  1.4

14) The Customer center uses your computer date to determine the year to display when selecting the fiscal period option.

Answer:  TRUE

Diff: 1
Page Ref: 23

Objective:  1.4

15) The Vendors tab on the Vendor center lists vendors and account balances to the right and highlighted vendor information to the left.

Answer:  FALSE

Diff: 3
Page Ref: 25

Objective:  1.4

16) Any center window can be resized by moving your mouse to the edge of the window where the cursor changes to a double headed arrow and then dragging the edge to resize.

Answer:  TRUE

Diff: 1
Page Ref: 26

Objective:  1.4

17) You can type specific questions into QuickBooks Help and find a list of information related to the topic.

Answer:  TRUE

Diff: 2
Page Ref: 35

Objective:  1.6

18) When backing up a company file, you are able to add the date and time of the backup to the file name.

Answer:  TRUE

Diff: 2
Page Ref: 41

Objective:  1.7

19) All the following apply to manual accounting EXCEPT:

A) business transactions occur and are manually entered onto a source document.

B) record the adjusting entries on the general journal and then post entries to the general ledger.

C) manually prepare the trial balance.

D) the software posts transactions to subsidiary journal, account ledger, and general ledger and records the audit trail.

Answer:  D

Diff: 2
Page Ref: 2

Objective:  1.1

20) All the following apply to computerized accounting EXCEPT:

A) business transactions occur and are entered into the accounting system.

B) accounting software posts transactions to subsidiary journal, account ledgers, and general ledger and records the audit trail.

C) closing entries are manually calculated and posted.

D) adjusting entries are recorded to general journal and software posts to general ledger.

Answer:  C

Diff: 2
Page Ref: 2

Objective:  1.1

21) Computerized accounting does the following EXCEPT:

A) minimizes posting errors.

B) protects the validity of data.

C) coordinates posting, reporting, and the audit trail.

D) makes it difficult to monitor transactions and analyze financial performance.

Answer:  D

Diff: 1
Page Ref: 2

Objective:  1.1

22) Computer hardware includes all the following EXCEPT:

A) QuickBooks.

B) Monitor.

C) CD-Rom.

D) Mouse.

Answer:  A

Diff: 1
Page Ref: 2

Objective:  1.1

23) The system software that translates user instructions to hardware components and application software is:

A) application software.

B) operating software.

C) system configuration.

D) program software.

Answer:  B

Diff: 2
Page Ref: 2

Objective:  1.1

24) Examples of operating software include the following EXCEPT:

A) Microsoft Windows XP.

B) Windows 2000.

C) Linux and UNIX.

D) QuickBooks.

Answer:  D

Diff: 1
Page Ref: 2

Objective:  1.1

25) Accounting software is normally organized by activities and these activities are:

A) customer and vendor activities.

B) banking and employee activities.

C) employee and company activities.

D) all the above.

Answer:  D

Diff: 2
Page Ref: 3

Objective:  1.1

26) QuickBooks company activities include:

A) general journal entries.

B) sales, accounts receivables, and cash receipts.

C) purchases, accounts payable, and cash disbursements.

D) payroll.

Answer:  A

Diff: 3
Page Ref: 3

Objective:  1.1

27) Customer activities in QuickBooks include:

A) general journal entries.

B) sales, accounts receivables, and cash receipts.

C) purchases, accounts payable, and cash disbursements.

D) payroll.

Answer:  B

Diff: 2
Page Ref: 3

Objective:  1.1

28) Vendor activities in QuickBooks include:

A) general journal entries.

B) sales, accounts receivables, and cash receipts.

C) purchases, accounts payable, and cash disbursements.

D) payroll.

Answer:  C

Diff: 2
Page Ref: 3

Objective:  1.1

29) Employee activities in QuickBooks include:

A) deposits and checks activities.

B) sales, accounts receivables, and cash receipts.

C) purchases, accounts payable, and cash disbursements.

D) payroll.

Answer:  D

Diff: 2
Page Ref: 3

Objective:  1.1

30) One method of opening an existing company is to select:

A) File>>New company.

B) File>>Open or Restore Company.

C) File>>Save Copy or Backup.

D) File>Restore an Existing Company>>.

Answer:  B

Diff: 2
Page Ref: 6, 7

Objective:  1.3

31) To use a QuickBooks backup file, select:

A) File>>Open>>Restore an Existing Company>>Open a company file.

B) File>>Open>>Restore an Existing Company>>Restore a backup copy.

C) File>>Open>>Restore an Existing Company>>Restore a portable file.

D) File>Restore an Existing Company>>.

Answer:  B

Diff: 2
Page Ref: 7

Objective:  1.3

32) To Open a portable company file created with QuickBooks select:

A) File>>Open>>Restore an Existing Company>>Open a company file.

B) File>>Open>>Restore an Existing Company>>Restore a backup copy.

C) File>>Open>>Restore an Existing Company>>Restore a portable file.

D) File>Restore an Existing Company>>.

Answer:  C

Diff: 2
Page Ref: 7

Objective:  1.3

33) To activate the Home page you can:

A) select Open>>Home.

B) click the Home icon.

C) click View>>Home.

D) click Customer center, then select Home.

Answer:  B

Diff: 2
Page Ref: 14

Objective:  1.4

34) The area on the desktop that displays the name of the open company is called the:

A) Title Bar.

B) Main Menu.

C) Icon Bar.

D) Home page.

Answer:  A

Diff: 2
Page Ref: 15

Objective:  1.4

35) The area on the desktop that displays the menus for executing QBP commands is called the:

A) Title Bar.

B) Main Menu.

C) Icon Bar.

D) Home page.

Answer:  B

Diff: 2
Page Ref: 15

Objective:  1.4

36) The area on the desktop that displays quick access to frequently used tasks is called the:

A) Title Bar.

B) Main Menu.

C) Icon Bar.

D) Home page.

Answer:  C

Diff: 2
Page Ref: 15

Objective:  1.4

37) The area on the desktop that displays icons for accessing vendor, customer, employee, company, and banking tasks and shows the workflow of tasks is called the:

A) Title Bar.

B) Main Menu.

C) Icon Bar.

D) Home page.

Answer:  D

Diff: 2
Page Ref: 15

Objective:  1.4

38) The icons on the Home page that are used to open the Vendors, Customers, and Employees centers are called:

A) Local Icons.

B) Icon Bar.

C) Center Icons.

D) Center Bar.

Answer:  C

Diff: 2
Page Ref: 15

Objective:  1.4

39) The menu command that gives you access to basic operations such as opening and closing companies, data backup and recovery operations, printing, and printer setup is the:

A) File menu.

B) Edit menu.

C) Lists menu.

D) Company menu.

Answer:  A

Diff: 2
Page Ref: 15

Objective:  1.4

40) The cut, copy, paste, delete, and undo commands are found under the:

A) File menu.

B) Edit menu.

C) Lists menu.

D) Company menu.

Answer:  B

Diff: 2
Page Ref: 15

Objective:  1.4

41) The commands used to open a list of customers, vendors, sales taxes, inventory, or chart of accounts are found under the:

A) File menu.

B) Edit menu.

C) Lists menu.

D) Company menu.

Answer:  C

Diff: 2
Page Ref: 15

Objective:  1.4

42) To access menus that allow you to enter company identifying information, close an accounting period, establish a budget, and set reminders and alerts, you must first select the:

A) Company menu.

B) Customers menu.

C) Vendors menu.

D) Employees menu.

Answer:  A

Diff: 2
Page Ref: 16

Objective:  1.4

43) The menu commands that allow you to invoice customers, receive payments from customers, and printing customer statements are found under the:

A) Company menu.

B) Customers menu.

C) Vendors menu.

D) Employees menu.

Answer:  B

Diff: 2
Page Ref: 16

Objective:  1.4

44) Banking activities include all the following EXCEPT:

A) reconcile.

B) marketing tools.

C) record deposits.

D) write checks.

Answer:  B

Diff: 2
Page Ref: 16

Objective:  1.4

45) The menu commands that allow you to enter vendor bills, remit payments to vendors, and manage inventory are found under the:

A) Company menu.

B) Customers menu.

C) Vendors menu.

D) Employees menu.

Answer:  C

Diff: 2
Page Ref: 16

Objective:  1.4

46) The menu commands that allow you to create paychecks, enter time cards, and pay payroll liabilities are found under the:

A) Company menu.

B) Customers menu.

C) Vendors menu.

D) Employees menu.

Answer:  D

Diff: 2
Page Ref: 16

Objective:  1.4

47) The menu commands that allow you to record bank deposits, write checks, and reconcile bank statements are found under the:

A) Reports menu.

B) Windows menu.

C) Help menu.

D) Banking menu.

Answer:  D

Diff: 2
Page Ref: 16

Objective:  1.4

48) The menu commands for printing a variety of reports used to analyze company performance are found under the:

A) Reports menu.

B) Windows menu.

C) Help menu.

D) Banking menu.

Answer:  A

Diff: 2
Page Ref: 16

Objective:  1.4

49) The menu command for activating an open task window when performing multiple tasks is found under the:

A) Reports menu.

B) Windows menu.

C) Help menu.

D) Banking menu.

Answer:  B

Diff: 2
Page Ref: 16

Objective:  1.4

50) The menu command for accessing help files, reviewing the software license agreement, and verifying the software version is found under the:

A) Reports menu.

B) Windows menu.

C) Help menu.

D) Banking menu.

Answer:  C

Diff: 2
Page Ref: 16

Objective:  1.4

51) The menu command used to open a task window when performing multiple tasks is found under the:

A) Reports menu.

B) Windows menu.

C) Help menu.

D) Banking menu.

Answer:  B

Diff: 2
Page Ref: 16

Objective:  1.4

52) The Home page for QBP is divided into five main sections called:

A) Clients, Expenses, Employees, Company, Help.

B) Customers, Payables, Employees, Payroll, Banking.

C) Receivables, Vendors, Corporations, Ledgers, Banking.

D) Customers, Vendors, Employees, Company, Banking.

Answer:  D

Diff: 2
Page Ref: 17

Objective:  1.4

53) The Vendors section of the Home page shows that the next step in processing a purchase order is to click the:

A) Receive Inventory icon.

B) Enter Bills Against Inventory icon.

C) Enter Bills icon.

D) any of the above.

Answer:  A

Diff: 2
Page Ref: 17

Objective:  1.4

54) On the Home page, customer activities include all the following EXCEPT:

A) create an invoice.

B) statement charges.

C) finance charges.

D) enter bills against inventory.

Answer:  D

Diff: 2
Page Ref: 17

Objective:  1.4

55) On the Home page, you are able to:

A) open the Charts of Accounts.

B) access Marketing Tools.

C) Adjust Quantity on Hand for inventory.

D) perform all of the above.

Answer:  D

Diff: 2
Page Ref: 17

Objective:  1.4

56) To customize the Icon Bar, you select the View menu and choose:

A) Customize All Bars.

B) Modify Icon Bar.

C) Customize Icon Bar.

D) Convert Icon Bar.

Answer:  C

Diff: 2
Page Ref: 20

Objective:  1.4

57) To add icons to the Icon bar, you select the View menu and choose:

A) Customize All Icon Bars.

B) Modify Icon Bar.

C) Add to Icon Bar.

D) Convert Icon Bar.

Answer:  C

Diff: 1
Page Ref: 20

Objective:  1.4

58) To add the Profit & Loss report as a shortcut on the Icon bar, you can first open the report and then choose:

A) Customize>>Memorized Reports.

B) View>>Add "Profit & Loss" to Icon Bar.

C) View>> Place Report on Icon Bar.

D) none of the above.

Answer:  B

Diff: 3
Page Ref: 21

Objective:  1.4

59) The Customer Center has two tabs that are called:

A) Customers & Invoices and Credits.

B) Customers & Jobs and Transactions.

C) Customers & Orders and Invoices.

D) Clients & Jobs and Transactions.

Answer:  B

Diff: 2
Page Ref: 22

Objective:  1.4

60) To view all open windows within QuickBooks, select:

A) the Window menu and scroll to the list at the bottom.

B) the View menu and scroll to the list at the bottom.

C) an icon on the main menu.

D) an icon on the window menu.

Answer:  A

Diff: 3
Page Ref: 26

Objective:  1.4

61) To cut highlighted text, you must press:

A) Ctrl + X.

B) Ctrl + C.

C) Ctrl + V.

D) Ctrl + Z.

Answer:  A

Diff: 1
Page Ref: 30

Objective:  1.4

62) To copy highlighted text, you must press:

A) Ctrl + X.

B) Ctrl + C.

C) Ctrl + V.

D) Ctrl + Z.

Answer:  B

Diff: 1
Page Ref: 30

Objective:  1.4

63) To Paste highlighted text, you must press:

A) Ctrl + X.

B) Ctrl + C.

C) Ctrl + V.

D) Ctrl + Z.

Answer:  C

Diff: 1
Page Ref: 30

Objective:  1.4

64) To Undo highlighted text, you must press:

A) Ctrl + X.

B) Ctrl + C.

C) Ctrl + V.

D) Ctrl + Z.

Answer:  D

Diff: 1
Page Ref: 30

Objective:  1.4

65) To Delete characters to the right, you must press:

A) Backspace.

B) Delete.

C) Ctrl + right arrow.

D) Ctrl + delete.

Answer:  B

Diff: 1
Page Ref: 30

Objective:  1.4

66) To Delete characters to the left, you must press:

A) Backspace.

B) Delete.

C) Ctrl + right arrow.

D) Ctrl + backspace.

Answer:  A

Diff: 1
Page Ref: 30

Objective:  1.4

67) To Delete an entire transaction, you must press:

A) Ctrl + T.

B) Ctrl + D.

C) Ctrl + E.

D) Ctrl + delete.

Answer:  B

Diff: 1
Page Ref: 30

Objective:  1.4

68) To delete an entire line, you must press:

A) Ctrl + Del.

B) Ctrl + Backspace.

C) Ctrl + Ins.

D) Ctrl + D.

Answer:  A

Diff: 2
Page Ref: 30

Objective:  1.4

69) To move to the next field:

A) Ctrl + right arrow.

B) Ctrl + Shift + right arrow.

C) Tab.

D) Ctrl + Tab.

Answer:  C

Diff: 1
Page Ref: 30

Objective:  1.4

70) To Open the Help files for the active window, you can press:

A) F1.

B) F2.

C) F3.

D) F4.

Answer:  A

Diff: 1
Page Ref: 30

Objective:  1.4

71) To Find a transaction, you can press:

A) Shift + F.

B) Ctrl + Shift + F.

C) Alt + F.

D) Ctrl + F.

Answer:  D

Diff: 1
Page Ref: 30

Objective:  1.4

72) To create a new transaction, you can press:

A) Shift + N.

B) Ctrl + N.

C) Alt + N.

D) Ctrl + Shift + N.

Answer:  B

Diff: 1
Page Ref: 30

Objective:  1.4

73) To open a transaction journal, you can press:

A) Ctrl + Y.

B) Shift + Y.

C) Alt + Y.

D) Ctrl + Shift + Y.

Answer:  A

Diff: 2
Page Ref: 30

Objective:  1.4

74) To memorize a transaction, you can press:

A) Ctrl + Shift + M.

B) Ctrl + M.

C) Shift + M.

D) Alt + M.

Answer:  B

Diff: 2
Page Ref: 30

Objective:  1.4

75) To Open a dropdown list for an item, you can press:

A) Ctrl + D.

B) Alt + L.

C) Shift + L.

D) Ctrl + L.

Answer:  D

Diff: 2
Page Ref: 30

Objective:  1.4

76) To Show a List, you can press:

A) Ctrl + L.

B) Ctrl + S.

C) Alt + S.

D) Ctrl + Shift + L.

Answer:  B

Diff: 2
Page Ref: 30

Objective:  1.4

77) To identify QBP reports as yours, you need to open the Company Information window and add your initials to the:

A) company name.

B) legal name.

C) both A and B.

D) neither A nor B.

Answer:  C

Diff: 1
Page Ref: 28

Objective:  1.5

78) To Open the Help window, you can select:

A) Help>>QuickBooks Assistant.

B) Windows>>Help>>QuickBooks Help.

C) Help>>Program.

D) Help>>QuickBooks Help.

Answer:  D

Diff: 2
Page Ref: 31

Objective:  1.6

79) The Help window has tabs named:

A) Search Options and Relevant Topics.

B) Index and Search.

C) Search and Help Index.

D) Relevant Topics and Search.

Answer:  D

Diff: 2
Page Ref: 32

Objective:  1.6

80) The name of the Help window tab that provides general help by topic is called the:

A) Relevant Topics tab.

B) Search Topics tab.

C) Index tab.

D) Search tab.

Answer:  A

Diff: 2
Page Ref: 32

Objective:  1.6

81) The Help window tab that allows you to search for specific terms is named the:

A) Search tab.

B) Relevant Topics tab.

C) Index tab.

D) Table of Contents tab.

Answer:  A

Diff: 1
Page Ref: 33

Objective:  1.6

82) When backing up a company file, you are able to:

A) add the date and time of the backup to the file name.

B) limit the number of backup copies to the folder.

C) change the location of the backup files.

D) all the above.

Answer:  D

Diff: 2
Page Ref: 41

Objective:  1.7

83) When restoring a company file, you are able to:

A) open a previous copy of a company file.

B) restore a backup copy.

C) restore a portable file.

D) all the above.

Answer:  D

Diff: 2
Page Ref: 44

Objective:  1.7

84) To prevent losing data in your existing company file when restoring a backup file, you should:

A) create a backup copy of the existing file before restoring.

B) convert the file.

C) delete the file.

D) resave the file with the same name.

Answer:  A

Diff: 2
Page Ref: 44

Objective:  1.7

85) When restoring a backup file, you can:

A) save the backup file to a company file with a different name.

B) replace the existing company file with data in the backup file.

C) delete the existing data file by saving over the current file.

D) all the above.

Answer:  D

Diff: 2
Page Ref: 47

Objective:  1.7

86) The type of software that serves specific needs of the user and is installed over operating software is called ________ software.

Answer:  application

Diff: 1
Page Ref: 3

Objective:  1.1

87) One type of application software that is used for typing letters, memos and reports within a company is Microsoft ________.

Answer:  Word

Diff: 1
Page Ref: 3

Objective:  1.1

88) One type of application software that is used to calculate financial analysis such as payroll or sales is Microsoft ________.

Answer:  Excel

Diff: 1
Page Ref: 3

Objective:  1.1

89) Application software that automates manual accounting procedures is ________ software.

Answer:  accounting

Diff: 1
Page Ref: 3

Objective:  1.1

90) On the Home page you are able to select Employees to record paycheck information, to pay payroll liabilities, and to process ________ forms.

Answer:  payroll

Diff: 2
Page Ref: 17

Objective:  1.4

91) On the Home page you are able to select Customers to create ________, receive payments, create sales receipts, view and print statements and charges and enter refunds and credits.

Answer:  invoices or sales invoices

Diff: 3
Page Ref: 17

Objective:  1.4

92) On the Home page you are able to select Banking to record ________, reconcile, write checks, print checks, and review the check register.

Answer:  deposits

Diff: 3
Page Ref: 17

Objective:  1.4

93) After entering a vendor receipt or bill, you can then ________ the vendor.

Answer:  pay

Diff: 2
Page Ref: 17

Objective:  1.4

94) The ________ button on the Title Bar of a window will reopen that window to its original size if it was minimized.

Answer:  Restore

Diff: 1
Page Ref: 27

Objective:  1.4

95) At the bottom of a Help topic, you can choose to submit comments to improve the topic by selecting the ________ icon.

Answer:  NO

Diff: 2
Page Ref: 37

Objective:  1.6

96) Each time you finish working on a company you should ________ the company data file.

Answer:  back up

Diff: 2
Page Ref: 38

Objective:  1.7

97) The ________ utility performs a backup on the company currently open in the software.

Answer:  backup

Diff: 2
Page Ref: 38

Objective:  1.7

98) To back up a company file select: File >> ________ on the main menu or click the Backup icon on the Icon bar to open the Backup window and choose next to complete the backup.

Answer:  Save Copy or Backup

Diff: 3
Page Ref: 38

Objective:  1.7

99) It is possible to back up a company file online or as a ________ backup.

Answer:  local

Diff: 3
Page Ref: 39

Objective:  1.7

100) The ________ procedures can be used to move data files between home and school.

Answer:  Backup and Restore

Diff: 2
Page Ref: 48

Objective:  1.7
1
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